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1 Introduction 
 

iPECS Phontage is a multi-media communication tool using a PC based application to link the 
operation of an on-screen multi-button telephone with other communications related PC 
applications.  iPECS Phontage is visualized on the desk-top and interfaced to the user via the 
mouse and keyboard.  All the features of the traditional iPECS multi-button phone are available to 
the user.  In addition, a Phonebook database with links to the user’s PIM (Personal Information 
Manager), provides pop-up windows for incoming caller identification.  iPECS Phontage users 
can employ the Phonebook to place calls as well as manage contact records.  The video interface 
delivers video for a multi-party conference with up to 2 or 3 participants.  File Sharing allows 
multiple parties in a conference to view and manipulate files simultaneously.  Other special 
functions available to iPECS Phontage users include: appointment scheduling, SMS support, E-
mail and call recording. 

The Phontage application is available in three versions, Basic, Pro, and Deluxe.  The Basic version 
provides the platform feature set.  The Pro supports the Basic feature set and additional features 
including video, conferencing, etc.  The Deluxe version includes the Pro feature set and adds 
recording and collaboration functionality.  The chart below indicates the features and functions of 
each version. 

BASIC PRO (Korea only) DELUXE 
 All Basic Features Plus All Pro Features Plus 

Login with ID and Password Video Conference, 2-party Video Conference, 3-party 
Local/Remote Connection Mode Video Data On/Off Status Voice Mail Backup and Management 
*Flexible Buttons (24) Outlook Call Popup with Exchange Server 3rd party Conversation Recording 
Multi-language support *Conference Management Auto Call Recording including 3rd Party 
Call By Name Transparent Main Window function File Collaboration (Application Sharing) 
*User SMS (Short Message Service) Call Assistance Window Internal Instant Messaging (IM-Chatting) 
Automatic Database Synchronization Favorite Contact Dialer *Flexible Buttons (48) 
Incoming Call Pop-up window Smart Recent Call List  
Hotkey Support   
Database Import/Export   
User Connection Profiles   
Smart Tray Icon & Menu   
Quick Call Menu   
Simple Dial-pad pop-up   
Display Mode (Clock, Calendar)   
Phone Book Calling   
Phone Book Management   
Scheduled Dial and Notification   
User Call Log management   
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BASIC PRO (Korea only) DELUXE 
 All Basic Features Plus All Pro Features Plus 

E-mail with Outlook   
Simple Favorites Contact List   
   

 

 
Note 1)

 Basic    – All System support (ipLDK/iPECS) 

          Pro (Korea version only)  - All System except iPECS 100/300/600 support 

          Deluxe    - Only iPECS 100/300/600 support

2) *
 These functions have a little differences depending on System Type. 
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2 Installation and setup 
Set-up of the iPECS Phontage is a four step process;  

1. connect the PC to the host System, 
2. install the iPECS Phontage application on the users’ PC, 
3. install system lock key and 
4. login to complete registration of the iPECS Phontage application to the System. 

Completing the login and registration process may require assistance of the system administrator to 
adjust settings of the System.  System will require a User Id and Password.  Also, for remote users, 
iPECS Phontage will require entry of the host System IP address.   

Prior to installation, the PC and operating system should be verified for compatibility with the 
iPECS Phontage application.  Assure that the PC and OS (Operating System) comply with the 
minimum requirements of sections 2.1 and 2.2. 

2.1 System requirements 
The minimum requirements for the iPECS Phontage PC are described below. 

 Pentium 4 or compatible CPU 
 1 GHz clock speed or higher 
 256 Mbytes RAM  
 200 Mbytes of free hard-drive space 
 1024 x 768 resolution monitor 
 CD-ROM drive  
 Video/Web cam, only required for real-time video 
 USB Headset (Recommended) 

2.2 Supported operating systems 
iPECS Phontage can run under any one of several Microsoft Operating Systems including: 

 Microsoft Windows 2003 
 Microsoft Windows XP Home 
 Microsoft Windows XP Professional. 
 Microsoft Windows 2000 Professional 

2.3 System Connection 
The PC with the Phontage application may be connected to the System either as a local or remote 
device.  Connecting as a local device requires Phontage connect to the same LAN as the host 
System.  When connecting as a remote device, the User ID and Password must be pre-registered in 
the System database.  Refer to 2.6.2 for additional information on remote operation.  Figure 2.3 
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provides a pictorial view of the connections to the System. 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 2.3 iPECS Phontage Connections 
 

2.4 Phontage Application Installation 
When the iPECS Phontage CD-ROM is placed in 
the PC, an auto-execute program will start and the 
install Wizard appears.  

 Press Next. 
 

 

 

 

 
 Enter User Name and Organization.  This information will be placed in About Window. 
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 Select your Phontage license type. 
Pro is for Korean only. 

 

 

 

 

 

 

 

 
 In the next installation step, the 

default destination folder for the 
Phontage application can be 
modified using the Change button.  
The default directory for installation 
is “C:\Program Files\Phontage\”.  
To continue the installation click the 
Next> button. 

 
 iPECS Phontage install wizard will 

complete the Phontage application 
installation. 

 

2.5 System Lock-key  
Prior to registration of iPECS Phontage with the host System, the host System will require 
installation of the Phontage software lock-key.  This is accomplished by the System administrator 
under the system’s Admin window.  The administrator should reference the System Admin Manual 
for guidance. 

 

2.6 Login & Registration  

2.6.1 Login 
To start the Phontage application; 

 Select the iPECS Phontage shortcut icon,            , to start the iPECS Phontage 
application and display the Login window 
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In the Login window, users enter 
User ID and Password, may check 
several option boxes to automate 
login and may enter a desired Station 
number which the system will honor 
if the number is available. 

*Only iPECS system supports Desired Number feature. 

In addition to Login information, the 
Login window accesses the Network Setting window for defining the device environment, see 
section 2.6.2. 

2.6.2 Network & Profile Setting 
Network Settings, accessed via the Login window, define 
the connection mode, Local or Remote, and the IP address 
of the host System.  To modify the Network Setting; 

 Select Local or Remote mode. 
 Enter System IP address if remote connection. 
 In the local mode, if the System IP Address is 

blank, Phontage will multi-cast discovery 
messages to locate a host. 

Defined Profiles can be selected from the drop-down list or 
added/edited/deleted with the Profile Name Tool icons. 

 Select Profile Name add or edit icon in the 
Network Setting window. 

 Select the mode and enter the IP address of the 
host. 

 Select OK to enter the Profile. 
    *ipLDK supports only remote connection. 

2.6.3 Registration Process 
Auto registration (iPECS System Only) 

When iPECS Phontage is run the first time, it attempts to register to iPECS with the User 
ID and Password.  The initial registration, when locally connected, is automatic assuming 
the iPECS system is set to allow registration, refer to the iPECS Description & Installation 
manual for the Registration Switch settings. 

Manual registration (All Systems) 

When iPECS Phontage is remotely connected or the iPECS is not set to allow new 
registrations, the Network settings must be changed from the Login window.  The connection 
mode (remote) and the System IP address must be entered, see section 2.6.2.  In addition, 

 2-4 iss. 4.0 

 



ECS                 Phontage Desk-top Installer & User Guide 
 

the Used ID and Password must be registered in the System under Station User Login 
program. 
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3 iPECS Phontage Overview 
iPECS Phontage interfaces with the user through the iPECS Phontage Main Window.  The 
Phontage Main Window incorporates several elements in the User Interface as shown below. 

Application Menu bar 
The Application Menu bar includes File administration, View windows selection, Tools access and 
Help access menus. 

Quick Call Menu bar 
Using these menu selections the user can place a call by pre-dialing a number with a mouse in the 
Simple Dial-pad pop-up, selecting a party from the Smart Recent Call List or the Simple Favorites 
List or using the PC keyboard to enter a number or Phonebook name. 

Simple Favorites List 
The Simple Favorites List is a list of names and corresponding numbers.  To simplify dialing of 
commonly used numbers, the user can populate the Simple Favorite List with a name and number 
only.  Selecting an item and the handset icon places the call. 

Info & Video Console 
Icons at the top of the Info & Video Console maintain a count of Voice Messages and SMS 
messages not heard or read as well as a count of missed calls.  The icons may be used to access the 
Message Lists window for simple access to a list of unopened messages or missed calls. 

The Console displays either the time of day or a monthly Calendar, which will show appointment 
dates in bold ink.  The Calendar links to Outlook scheduler allowing appointments to be added or 
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modified from iPECS Phontage. 

The Record button can be used to record a conversation and store the recording on the local PC 
hard drive.  The recording can be reviewed, sent as an E-mail attachment with a commentary or 
deleted.  

The iPECS Phontage supports Video communications with an automatic link to a standard PC 
camera.  Activate the video camera using the Video button for a preview then, open the channel to 
send real-time video to the remote party.  More importantly to the business user, files may be shared 
in a collaborative multi-party conference session; each party has access to and can edit the 
application file over the iPECS Phontage link.  Select the Application Sharing icon then, select 
from the open file list.  The file is opened and displayed to all parties.  Any of the parties may 
manipulate the contents in real-time with the Handover function.  

*Application Sharing is only for iPECS System. 

Basic Call Control Menu bar 
The Basic Call Control Menu bar includes separate slide volume controls for the speaker and 
microphone as well as Transfer, Conference, Hold and Speaker buttons.  In addition, on the far left 
the Text Message button will access SMS and IM windows. *IM Window is only for iPECS System. 

Window View Icon Menu bar 
The Phontage Window View Icon Menu bar opens the various iPECS Phontage optional windows 
such as the Phonebook, Call Log, Schedule Dial, IP Phone, Flex button, etc.  The Phonebook screen 
displays information on contacts registered in the contact manger database.  The Phonebook is 
employed to place calls and send e-mails and can be searched, sorted and edited.  The Phonebook 
database can be imported from and synchronized with an external source database each time the 
iPECS Phontage application is opened.  Also, changes made to the Phonebook database can be 
automatically exported to the external database to maintain synchronization. 

The Call Log window maintains a database with a record of each call placed or received by the 
iPECS Phontage.  The Call Log, if enabled, can be viewed, sorted and printed or can be disabled 
so no log records are generated. 

The Recorded Call List window gives access to tools allowing the user to manage calls previously 
recorded.  Recordings can be played, sent as an E-Mail attachment, deleted, etc. 

In the Scheduled Dial window the user can input a phone number and a date & time to call the 
number; at the scheduled time the system will confirm and place the requested call. 

The IP Phone and Flex Button windows give the user an interface to iPECS with the simple 
convenient operation of the traditional iPECS multi-button phone. 
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4 Quick Call Menu bar 
 

 

 

 

4.1 Placing a Call 
Placing a call with the Quick Call Menu is quick and efficient.  For your convenience, a number of 
calling options are available. 

To place a call; 

 Option 1 Simple dial-pad pop-up. 
 Select the Simple Dial-pad pop-up with the dial-pad icon. 
 Use the mouse to select and click digits which are then 

displayed in the pre-dial box. 

Simple Dial-pad 
pop-up control 

 Press Call to place the call. 
 

 Option 2 Smart Recent Call List, maintains a list of calls. 
 Select the Smart Recent Call List with drop-down 

arrow in the pre-dial box. 
Drop-down arrow 
in Pre-dial box 

 Select the desired entry. 
 Press Call to place the call. 

 

 Option 3 Simple Favorites Contact List. 

Simple 
Favorites List 

 Double-click an entry from the Simple Favorites List to place 
the call. 

 

 

 

 

 

 Option 4 PC Keyboard dialing. 
 Use the PC keyboard to enter digits or Phonebook 

name; entries appear in the pre-dial box as entered. 
 Press Call to place the call. 
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To end the call; 
 Select the Telephone icon from the Basic Call Control Menu bar. 

 

Calls may also be placed directly from the Phonebook or Call Log windows.  In addition, opening 
the IP Phone window permits placing calls as with any iPECS terminal. 

Calls can be placed from other applications while the iPECS Phontage is active or minimized.  
To place a call from another application; 

 Copy the desired digit string (Ctrl + C) 
 Press the “Ctrl + Shift + D”. 

 

4.2 Receiving a Call 
When a call is received, the phone will ‘ring’ and the selected Caller Information pop-up window, 
see section 5.1.2.5, will appear.  The window shows the caller id delivered from the System and 
the name associated from the Phonebook database.  If Phontage is minimized, the Caller 
Information window will pop-up to display the incoming call information or the iPECS 
Phontage icon in the Windows tray will flash to indicate the new call.  In the later case, iPECS 
Phontage must be opened to answer the call. 

To answer the call with Phontage active; 
 Select the Telephone icon from the Basic Call 

Control Menu bar. 
 

To answer the call with Phontage minimized; 
 Select the Telephone icon or Phontage icon from the Caller Information pop-up 

window.(Enter and Space Bar are short-cut Key) 
 

 

 

 

 

To end the call; 
 Select the Telephone icon from the Basic Call 

Control Menu bar. 
(Enter and Space Bar are short-cut Key) 

 

 4-2 iss. 4.0 

 



ECS                 Phontage Desk-top Installer & User Guide 
 

5 Application Menu bar 
 

 

 

5.1 File 
Selecting the File item from the Application Menu bar shows the File menu 
selections. 

 

 

 

 

5.1.1 File - Logout: 
The Logout selection logs the active user out of 
the iPECS Phontage application and displays 
the Login screen.  Closing the Login window 
terminates the application. 

Checking the Desired Number box permits 
entry of a preferred station number for the 
iPECS Phontage.  If available, the iPECS will 
use the desired number as the station number 
for Phontage. *Desired Number is for only iPECS system. 

5.1.2 File - Setting 
The Setting selection displays the 
Setting sub-menu.  The user can 
establish the connection mode, 
language, dialing rules, ring tone, etc. 

*ipLDK system supports only remote connection mode. 
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5.1.2.1 File - Setting- System Connection 
iPECS Phontage can be registered to an System in Local or Remote Mode.  In the Remote 
Mode, iPECS allocates a VoIP channel to support the 
call.  The VoIP channel implements NAPT (Network 
Address & Port Translation) compatibility and packet 
forwarding to internal appliances. 

Selecting System Connection displays the System 
Connection window with the present mode 
(Local/Remote) checked.  When either mode is 
selected, the iPECS Phontage will terminate and re-
connect with the host System to establish the selected 
connection mode.  Also in this window, the host 
System IP address and a Network Adapter Ethernet 
MAC address can be entered or selected. 

5.1.2.2 File- Setting- Password Change 
Selecting Password Change displays the Change 
Password window where the iPECS Phontage access 
password can be changed.   The correct current 
password must be entered followed by the new 
password, which must also be confirmed. 

*iPECS system only 

5.1.2.3 File- Setting- Language 
iPECS Phontage supports multiple languages, English as the default and a Local Language.  
The Local Language is translated from English and edited into the ‘language.txt’ file located 
in the iPECS Phontage program directory.  For additional help, access the ‘language.txt’ 
text file in the iPECS Phontage folder. 

Selecting Language displays the English/Local Language selection box with the present 
mode checked. When selecting the desired language, the iPECS Phontage will 
automatically change all text and messages to the desired language. 
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5.1.2.4 File- Setting- Dialing Rules 
When you place an outside call from the Phonebook or Call Log window, iPECS Phontage 
must include or remove certain dial codes to assure 
proper dialing through the iPECS.  When a number 
is selected from either window, the system will 
compare the number to the dialing rules codes.  The 
dialing rules country and area codes are compared 
to the number and if matched are deleted from the 
number.  If not matched, the appropriate LD or 
International codes are inserted preceded by the 
PBX and CO or IP line access codes.  Codes are 
entered in the Dialing Rules dialog box, along with 
local codes for comparison.  To enter codes; 

 Select Dialing Rules from the Setting menu. 
 Enter the various codes. 
 Select OK. 

For proper operation, Phonebook entries should follow normal conventions: 

“+country code (area code) number” [+82 (31) 450-4636] 

5.1.2.5 File- Setting- Popup & Outlook 
When an incoming call is received, Phontage provides one of several Call Id pop-up 
windows.  In addition, the pop-up can be displayed 
for an outgoing call.  The selection of pop-up and 
when the pop-up is displayed is assigned in the 
Popup & Outlook window.  Note the “Multi-call” 
type pop-up provides added information for DID call 
types. 

To define the pop-up use; 

 Select Popup & Outlook from the Setting menu. 
 Select the desired Pop-up.  Popup selections include Phontage Simple, Graphic and 

Multi-Call or the Outlook Contact window. 
 Select the desired Pop-up Timing. 
 Select OK. 
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The Outlook pop-up is normally employed for external calls but can also be used for internal 
calls by selecting Internal Call in the Popup & Outlook window.  Note your Outlook contacts 
must then include internal users to display the proper contact information. 

5.1.2.6 File- Setting- Call Log (On/Off) 
iPECS Phontage can maintain a list of all 
calls to the phone.  Selecting Setting then 
Call Log, will display the On/Off selection 
box with the present mode checked. When 
enabled, the Call Log is available for 
viewing and use. 

 

 

 

 

5.1.2.7 File- Setting- Differential Ring 
The iPECS Phontage can provide one of 4 different ring signals with separate assignments 
for internal and external calls.  Each 
of the 4 ring signals is contained in a 
*.wav file.  You may select one of the 
4 predefined *.wav files (ring1.wav, 
ring2.wav, ring3.wav and ring4.wav) 
or replace any of these files with a 
desired *.wav or *.mp3 file. Note: 
that standard wave or MP3 files are 
supported.  For wave files, 8 and 16 
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bit encoding, both mono and stereo, at 8.0, 11.025, 22.05 and 44..1 KHz sampling are 
supported. 

Selecting Differential Ring opens the Bell Sound window.  To change a Ring tone file, 

 Select the change spyglass icon next to file to be replaced. 
 Select the desired *.wav or *.mp3 file from the PC’s file system. 
 Select Change. 
 Select Listen at any time to hear the ring tone. 
 Select OK to close the Ring tone files window and the new file may be selected for use. 

 

To select a Ring Tone for use; 

 Open the IP Phone window, see section 9.6. 
 Click the PGM fixed feature button, 
 Dial 1 for Ring Tone Selection. 
 Dial 1 for Intercom Ring or 2 for CO/IP ring. 
 Dial desired Ring Tone (1-4), a short burst of the tone is generated. 
 Press SAVE. 

*ipLDK supports Ring 1 only 

5.1.2.8 File- Setting- Audio Control 
Phontage can control the audio input/output device 
employed.  The devices for audio input and output are 
selected in the Audio Setting screen.  The audio output device 
(received audio) can be defined separately for voice and ring 
signals.  Selecting the Audio device drop-down menu will 
display the device choices available. 

 

 

 

5.1.3 File - Stay On Top 
Checking the ‘Stay On Top’ item from the File menu will cause the iPECS Phontage Main 
Display to stay on top of other desktop displays.  Thus, the Phontage application is always 
available to you. 

5.1.4 File - Transparent Window 
The iPECS Phontage Main Window can be made transparent, which lets you view underlying 
windows of other applications.  The Transparent Window can be set at one of four transparency 
levels, High, Middle, Low or none (Restore). 
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5.1.5 File - Go To Tray 
The ‘Go To Tray’ selection minimizes the iPECS Phontage application to the system tray. 

5.1.6 File - Exit 
The Exit selection terminates and closes the iPECS Phontage application. 

 

5.2 View 
The View item allows access to the iPECS Phontage optional windows and controls display of 
the Window View Icon Menu bar.  Optional windows 
available are: 

 Phonebook 
 Call Log 
 Recorded Call List 
 Schedule Dial 
 Conference Room 
 IP Phone 
 Flex Button 

 

Details on each optional window are provided in section 9. 

The last item in the View menu (View Toolbar) controls display of the Window View Icon Menu bar.  
Checking the View Toolbar enables display of the Icon Menu bar at the bottom of the iPECS 
Phontage Main Window. 

 

5.3 Tools Menu 
From the Tools menu you manage the 
Phonebook, Short-cut keys and Call 
Forward settings.  In addition, Recording, 
Video-cam Calls and Application sharing 
functions can be activated in the Tools 
menu.  
*Only iPECS system supports  ‘ Forward’ menu. 

 

5.3.1 Tools - Phonebook Management 
Selecting Phonebook from the File menu will present the Phonebook menu where the user may 

 5-6 iss. 4.0 

 



ECS                 Phontage Desk-top Installer & User Guide 
 

manage the Phonebook database.  From this menu, you may select to open a new or existing 
database, save a database, import or export a database or maintain synchronization with an 
external database.  Once a Phonebook is opened, operation of the window is as discussed in 
section 9.1. 

The user may open a new blank database for use with the Phonebook window; 

 select New from the menu, 
 select a folder location, 
 enter a filename. 

You may select the database to employ for the Phonebook window.  Once selected, the database 
is used for iPECS Phontage Phonebook until a new selection is made by the user.  To open a 
selected database; 

 Select Open from the menu. 
 Select a database.  The file format of the database must be consistent with the *.CDS file 

format of the iPECS Phontage database; other file type selections will receive a 
warning message. 

Various contact manager applications employ different data formats.  To permit use of common 
formats, iPECS Phontage allows you to import databases from Outlook, GoldMine, ACT! or 
Excel applications.  When imported, the database format is modified to match the Phonebook 
database and displayed in the Phonebook window.  To import a database; 

 Select Import from the Phonebook menu. 
 Select the application type, Outlook, Gold Mine, ACT! or Excel. 
 Select the database. 

You may save a copy of the Phonebook database as a back-up copy or for future use.  To save a 
copy of a database; 

 Select Save As from the Phonebook menu. 
 Select a folder, if different than the iPECS Phontage folder. 
 Select the filename. 
 Select Save. 

The Phonebook database can be exported for use in other applications including Outlook, Gold 
Mine, and ACT! or Excel.  To export a Phonebook database; 

 Select Export from the Phonebook menu. 
 Select the application type, Outlook, Gold Mine, ACT! or Excel. 
 Select the database. 

The Phonebook can be synchronized with an external Outlook, Gold Mine or ACT! database 
automatically.  When synchronized (auto importing), each time the iPECS Phontage is started 
it will use the external database as the Phonebook. 

 To enable automatic synchronization, 

 5-7 iss. 4.0 

 



ECS                 Phontage Desk-top Installer & User Guide 
 

 Select Sync Database from the Phonebook menu. 
Condition: There should be imported database at once. Latest imported database will be 
imported into Phonebook automatically.  

 

Note that changes made directly to an external database are not effective in an active iPECS 
Phontage.  Such changes require a restart of the iPECS Phontage application to update the 
active Phonebook database.  Also, during import or export of an Excel file, do not close the file. 

5.3.2 Tools - Short Cut Management 
While iPECS Phontage is active, Short Cut or Hotkeys are 
available for quick access to functions within the application 
as shown in the Hotkey Setting window.  Hotkey settings can 
be modified to meet your needs.  To modify the Hotkey 
assignments, 

 Select the desired Hotkey 
 Enter Hotkey combination 
 Select the add icon, , to confirm and store the new 

combination. 
 

5.3.3 Tools - Call Assistant 
The Call Assistant bar is an unobtrusive mechanism to place and receive calls.  The bar is similar 
to the Quick Call Menu bar and is always displayed on-top of the Windows desk-top to minimize 
interference with the desk-top display.  The bar may be dragged and dropped to any location on 
the user’s desktop. 

 

 

 

The Contact List 
window in the Call Assistant bar displays the user’s Phonebook and Favorites List for quick 
dialing or, dial from the desk-top numeric keyboard.  The Call Assistant bar can be displayed 
with a small version of the IP Phone LCD. 

To place a call from the Call Assistant, 

 Select the drop down arrow to display the Contact List. Drop-down arrow 
in Contact List 
window.  Double click on the desired entry. 

 Or, 
 Click in the Call Assistant window. 
 Dial with the desk-top numeric keys. 
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 Click Call. 
To add the LCD to the Call Assistant bar, 

 Right click on the Call Assistant. 
 Select Display LCD from the menu. 

5.3.4 Favorite Contact Dialer 
The Favorite Contact Dialer, which is always displayed on-top of 
other desk-top screens, is populated from the Favorite Contacts List 
in the Info and Video Console.  Selecting a name from the Dialer 
places a call to the user.  The Dialer is semi-transparent and may be 
dragged and dropped to an unobtrusive location on the user’s desk-
top. 

5.3.5 Voice Record 
iPECS Phontage uses your PC hard drive to record an active call.  Recording a call is 
controlled using the Voice Record selection in the Tools menu, the Ctrl-Alt-R Short-cut keys, or 
the Record button in the Info & Video Console.  For detailed operation refer to section 6.5. 

5.3.6 Video Cam Display 
iPECS Phontage uses your PC cam and application to implement real-time video 
communications over an IP based network.  Video calls can be established using the Video 
Display selection in the Tools menu, the Ctrl-Alt-V Short-cut keys, or the Video button in the 
Info & Video Console.  For detailed operation refer to section 6.6. 

5.3.7 Application Sharing 
iPECS Phontage users can share file applications over an iPECS TCP connection.  File sharing 
can be initiated with the Application Sharing selection in the Tools menu, the Ctrl-Alt-S Short-cut 
keys or the Sharing button in the Info & Video Console.  For detailed operation refer to section 
6.7. 

5.3.8 Tools - Call Forward 
You may select to re-route incoming calls to other 
stations (Internal Stations, Network Stations), station 
groups, the system Voice Mail, or over CO/IP 
resources. 

To activate Call Forward, Unconditional or Busy/No 
Answer 

* This window is supported by iPECS system. The other systems can support this 

forward function by flex button and IP Phone window. 
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 From the Tools menu select Forward to display the Forward control window. 
 Select the desired Call Forward type. 
 Input the station or station group to receive calls. 
 Select OK. 

To activate Call Forward, Off Premise (to an external number) 

 Check SPEED from the Forward control window. 
 Select desired Call Forward type. 
 Input desired bin number. 
 Select OK. 

To activate Call Forward, Remote (Follow-me) 

 Select REMOTE from the Forward control window. 
 Select desired Call Forward type. 
 Input the station’s Authorization Code (Station number & password), 
 Input the station or station group. 
 Select OK. 

To deactivate Call forward 

 Select Clear as the Forward type 
 Select OK. 

5.3.9 Tools - E-Mail 
With the iPECS Phontage, you can access the Outlook E-mail application to send ad hoc E-
mails.  Access to the E-mail application is provided by the E-Mail item in the Tools menu, which 
calls your Outlook E-mail application.  The E-mail application can also be called from the 
Phonebook window section 9.1. 

 

5.4 Help Menu 

5.4.1 Help- Help F1 
The Help item from the help menu launches PDF help file named ‘Phontage_UG.pdf’. This file 
should be placed in the installed program directory and also Adobe Reader should be installed on 
your PC. 
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5.4.2 Help - About 
The About item from the Help menu 
displays the version for the iPECS 
Phontage. 
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6 Info & Video Console 

 

6.1 Logout 
The Logout selection, located in the upper right area of the console, logs the current user out of the 
iPECS Phontage application and returns the Login screen. 

6.2 Message Icons 
At the top right of the Console are the Voice Message, SMS message and Missed Calls icons.  
Next to each is a counter for each icon.  
The icons access the Message Lists 
window with a view of messages in the 
selected list (Voice Mail, SMS, and 
Missed Call).  Messages are played or 
read and managed from the Tool bar.  
Messages can be deleted or a call or, in 
SMS, a message returned. 

When assigned in the iPECS system, the 
Phontage may receive notification for 
other users as a back-up station, see 
section 10.2.  
* iPECS 100/300/600 are not able to save SMS more than 10 messages, so if you want to receive more message you need to 

read system message from system by clicking SMS Icon or Refresh button on SMS window. 

6.3 Clock-Calendar View 
The clock and calendar icons control the Console showing current time or monthly calendar with 
links to Outlook, see section 6.4. 

 
Clock/Calendar 
icons 
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6.4 Appointment Calendar 
iPECS Phontage Calendar displays a monthly calendar with the current date in green and any 
date with appointments in bold text.  By right clicking the mouse over a date on the calendar, an 
Appointment Summary window is displayed over the Schedule window. 

The iPECS Phontage Calendar display permits on screen access to Outlook scheduler in two 
ways; 

 Double click on a date in the 
Calendar display. 

Or 

 Right click the mouse over the 
calendar date 

 In the Summary window, double 
click an appointment. 

 

 

 

iPECS Phontage will ‘call’ Outlook Scheduler so you can add or modify an appointment in the 
Scheduler edit window. 

 Enter a new or edit an 
appointment following the 
Outlook instructions.  When 
complete, save and close the 
Appointment.  This saves the 
Appointment in Outlook and 
updates the iPECS Phontage 
database. 

 

 

 

 

6.5 Call Recording 
iPECS Phontage uses your PC hard drive to record an active call.  The recorded files are then 
managed in the Recorded Calls List accessed from the View menu or directly from the Recorded 
Calls List button in the Window View Icon Menu, see section 9.3.  A recording is initiated using 
the Record button, which illuminates to indicate recording in progress. 
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6.6 Video-cam Calls 
The iPECS Phontage uses your PC cam and application to implement real-time video 
communications over an IP based network.  The real-time video supports transport of H.263 
standard video codecs.  The frame rate may be increased to 15-frames/second but packet loss and 
delay may become excessive and lower frame rates may perform better with other services.  When 
a video call is placed, an IM chat channel is also opened and can be accessed via the Text Message 
window, see section 8.3.2. 

To initiate a video call; 
 Place a call to another 

Phontage user. 
 Select Video for a preview 

of the Video-cam output. 
 Select Send to transmit 

Video. 
 

To receive a video call; 
 Receive a call from another Phontage user. 
 Select Video for a preview of the Video-cam output. 
 Select Send to transmit Video. 

 

To mute (turn-off) video transmission; 
 Right click over your video 

image. 
 Select Stop from the pop-up 

selection box. 
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To enlarge the received video window 
 Double or right click on the 

receive window. 
 Select Video Large Display 

 

 

 

 

 

6.7 Application Sharing 
iPECS Phontage users can share file applications over the iPECS TCP connection.  Any active 
or minimized file can be viewed and manipulated by all parties.  Control over the file and 
application can be shared for a collaborative session handling presentations, drawings, documents, 
etc. 

The Sharing button displays the Sharing Master window.  The Sharing Master window displays 
files available for collaborative sharing.  Only active or minimized files can be accessed by the 
iPECS Phontage sharing application.  

To share an application file; 
 Select the Sharing button. 
 Select the file in the Sharing Master 

window. 
 Select the Start button to begin the 

sharing session. 
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The Application sharing window includes a Menu bar at the top.  When a user is given control, the 
Title turns to a red color.  The connected party may be allowed control for input and locally 
storing the file.  To shift the controlling user; 

 Select the Handover icon. 
 Select the radio button for the desired user, the title in the upper menu bar turns to a red 

color. 
Files are sent by the controller (master) to the other party periodically.  The interval is from 1 to 
10.0 seconds, 5 seconds generally appears acceptable for most collaborative work while longer 
periods are acceptable for reviews.  To adjust the interval; 

 From the Sharing Master window, select the Frame Interval drop-down menu. 
 Select the desired interval. 

 
* This function is supported by iPECS system. 
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7 Simple Favorites & Connected Lists 
7.1 Simple Favorites Contact List 

The Simple Favorites List is a list of names and corresponding numbers.  To 
simplify dialing of commonly used numbers, you can populate the Simple 
Favorite List with a name and number only.  Selecting an item and the 
handset icon will place the call. 

 

From this window, a Favorite contact can be added, modified or deleted. 

To add or modify the contact list 
 Select the contact. 
 Select the add icon. 
 Enter the Display Name and Phone Number 
 Select OK to add a contact to the Simple 

Favorites Contact List. 
 

7.2 Connected Parties List 
While on a call, the Connected Parties List is displayed in place of the Simple 
Favorites List.  The List shows the number of external and internal parties in 
the conversation including a conference.  In the ipLDK, only the conference 
initiator will see other parties in a conference. 
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8 Basic Call Control Menu bar 
 

 

 

 

8.1 Volume Controls 
Separate slide controls are provided for adjusting the Speaker level; with the mouse drag the slide 
button right to increase volume, drag left to decrease volume. Microphone volume level is 
adjusted automatically. 

8.2 Call Handling buttons 
On the Basic Call Control Menu bar are several buttons for quick access to common call handling 
features.  Buttons available are: 

 Transfer, initiates a call transfer. 

 Conference, initiate and set-up a conference call. 

 Hold, places the active call on Hold. 

 Speaker, used to answer and end calls. 

8.3 SMS & IM Window 

8.3.1 SMS Window 
SMS (Short Message Service), which is typically provided in GSM mobile networks, is a service 
permitting you to share (send and receive) text messages with other users.  A text message is 
comprised of an alphanumeric combination of up to 100 characters.  An SMS can be sent 
employing the Text Message Window or as a reply to a received message, see section 6.2.  The 

Text Message 
Window access 
button 
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iPECS Phontage maintains up to ten received messages after which, new messages are ignored. 

To send a text message to other users; 

 Select the Text Message button. 
 If needed, select the SMS tab to show the SMS window. 
 Enter text message. 
 Select Send in the SMS window, the Member window appears. 
 Select the desired recipients with the check boxes. 
 Select Send to deliver the message. 

*Station Lists window is for only iPECS system. 

8.3.2 IM Window 
The IM window sends and receives an instant messaging dialogue between the parties connected 
in a Video-cam call.  In the IM window you may initiate or interact in an IM dialogue with other 
internal users connected during an active call. 

To use the window: 

 Select the Text Message button to access the window. 
 If needed, select the IM tab to show the IM window. 
 Type message and select SEND. 

 

To adjust fonts; 

 Select the Character icon, bottom left, and select the font characteristics. 
 

 

 

 

 

 

 

 

 

 
Text Message Window 
access button 

*For Only iPECS system.       
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9 Window View Icon Menu bar  
The Window View Icon Menu bar gives quick access to the various optional windows of the iPECS 
Phontage application. 

 

Optional windows include: 

 Phonebook 
 Call Log 
 Recorded Calls 
 Schedule Dial 
 Conference Room 
 IP Phone 
 Flex Buttons 

Only one of the database windows (Phonebook, Call Log, Recorded Calls, Schedule Dial and 
Conference Room) can be opened at a time.  A database, IP Phone and Flex Buttons windows can 
be opened simultaneously.  The window size is adjustable except for the IP Phone window. 
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9.1 Phonebook Window 
iPECS Phontage maintains a Phonebook database of your contacts; both other iPECS users and 
external contacts may be included.  You can place calls and send E-mails to contacts selected from 
the database employing the search, sort and record management tools on the Phonebook Tool bar.  
When a record is added, edited or deleted in the Phonebook, Phontage can also update 
(synchronize) the original source database, 
refer to section 5.3.1. 

To call a number from the Phonebook; 
 Right click on the desired record, 

see search & sort below. 
 Select the desired function from 

the drop-down menu: Make a 
Call, Transfer (Screened), 
Transfer (Unscreened), Make a 
Conference, etc. 

 Or 
 Select the desired record. 
 Click the Telephone icon in the 

Phonebook Tool bar. 
 Or 

 Double click on the desired record or phone number field. 
To send an E-mail from the database; 

 Select the desired record(s). 
 Select the E-Mail icon from the Phonebook Tool bar, the Outlook E-mail program is 

called and loaded with the selected recipients. 
 Type in subject, message, and send the e-mail. 

To search the Phonebook database; 
 Enter an alphanumeric string in the 

search box. 
To sort records in the Phonebook; 

 Click on the header field at the top of 
the Phonebook to sort 
alphabetically/numerically, click 
again for reverse order. 

To add or edit a record; 
 Select desired record for edit. 
 Click Add or Edit icon to view the 

Contact Record form. 
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 Fill in the form, Name is a required field.  To remove an image from the contact record, 
right click on the image to view the Clear Image pop-up dialog box.  Select Clear Image 
and OK. 

 Select OK to save the record in the Phonebook and synchronize the source database. 
To delete a record; 

 Select the desired record(s), 
 Click the delete icon in the Phonebook Tool bar.  

 

9.2 Call Log Window 
The Call Log window is a log of all 
calls placed or received by the iPECS 
Phontage.  If Call Log is enabled under 
the File - Setting menu, each call, 
initiated or received, will generate a 
record, which will contain information 
on the call as well as data derived from 
the Phonebook.  Once the call 
terminates, a record is stored in the Call 
Log database.  The record will contain 
the following fields: 

 Date & Time: date and time of the 
call from the user’s PC 

 Name: name of connected party from the Phonebook 
 Phone: the called or calling party phone number, from the iPECS or carrier 
 Call Type: type of call icon, incoming/outgoing and answer/no answer 
 Duration: duration the call was connected or ringing in hours, minutes and seconds 

The Tool bar at the top of the Call Log window, allows the user to place a call and manage the Call 
Log database.  To place a call from the Call Log window; 

 Double click on the record to place the call. 
 Or 

 Select a record. 
 Click the Telephone icon, iPECS Phontage will place a call to the phone number of 

record. 
To copy a record to the Phonebook  

 Right click on the desired record. 
 Click Add New (Phone Book). 
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Selecting the Delete icon will remove the selected record(s); selecting the Del All icon will delete 
all records in the Call Log. 

9.3 Recorded Call List 
iPECS Phontage permits recording of a conversation onto the PC’s hard drive.  Recorded 
conversations can be reviewed after recording.  In addition, voice memos can be added to the 
recording and the recording with memo sent by E-
mail as attached *.wav files. 

Recording may be activated from the Phontage 
Tools item in the Application Menu bar, from the 
Info & Video Console Record button, using the 
Voice Mail back-up feature or automatically.  
iPECS Phontage sends a single “record-start” 
tone; you should notify the other parties to any 
recording. 

The Recorded Call List window includes playback controls for playing a selected file.  The user 
may delete a file, record a comment, and/or E-mail the recording using the Playback window 
controls. 

9.4 Scheduled Dial Window 
Scheduled Dialing permits the user to enter a phone 
number for dialing at a later scheduled time.  When 
the scheduled time is reached, the Confirm window 
will appear and must be confirmed by the user 
before dialing will begin. 

The Scheduled Dial window contains a list of the 
phone numbers and schedules entered by you.  The window Tool bar permits you to manage the 
Scheduled dialing feature.  

To add or edit a Schedule Dial; 
 Click the Add or Edit icon on the window 

Tool bar and the Schedule Dial dialog box 
appears. 

  
  
  
  
 Click the pull-down Date/Time menu. 

 9-4 iss. 4.0 

 



ECS                 Phontage Desk-top Installer & User Guide 
 

 Select a date from the calendar and the time menu, date & time is a required entry. 
 Input or edit the telephone number, the 

telephone number is a required entry. 
 If desired, enter or edit Name and 

Company. 
 Select OK to save the schedule and 

number for later dialing.  A date, time and 
number must be entered. 

To delete an entry from the Scheduled Dial folder; 
 Select the Delete or Delete All icon to remove the record.  The user will be asked to 

confirm the record deletion. 
 

9.5 Conference Room Window 
iPECS Phontage includes the Conference Room feature where you can set-up or join a 
scheduled Conference.  To set-up a Conference 
Room; 

 Select Conference Room from the View 
menu. 

 Select Create tab. 
 Enter an Access Code if need. 
 Press Create button. The Room number 

will be given from system. 
To send an E-mail notification of the Conference; 

 Select and enter a Subject. 
 Select and enter the E-mail address for the Receivers. 
 Select a Date & Time from the drop-down menu. 
 Enter a contents message. 
 Select Send to Email. 

iPECS Phontage will register the Conference 
Room and send an E-Mail to the listed receivers. 

You can also join a Conference Room. 

To enter a Conference; 

 Select Conference Room from the View 
menu. 

 Select the Enter tab. 
 Enter Room Number and Access Code. 
 Select Join. 
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*ipLDK and iPECS 100/300/600 support auto creation of room number. The other systems should be entered room number also like access code. 

For all system, room number should be entered when you want to remove the room from system. 

9.6 IP Phone Window 
With the IP Phone Window you have 
complete access to all of the system 
features as well as the features available 
to the traditional IP phones, with the few 
exceptions based on the differences in the 
user platform, refer to section 12.  The 
fixed feature keys operate in the same 
manner as the IP phones except the 
mouse is used to select dial pad and 
feature buttons.  For operation of the 
features, refer to the System Quick Guide 
or the IP Phone User Guide. 

 

9.7 Flex Button Window 
The Flex Button window provides access to 
the 48 Flex buttons in the screen.  Each 
button includes a status icon, which 
displays the status of the CO Line or station 
associated with the button.  The button also 
displays a designation from the System 
database, such as CO 001, SPD 001, etc.  A 
further label, which will be displayed in the 
button, can be assigned in Phontage. 

Selecting a Flex button with the left mouse 
button will access a CO line, call a station 
or activate a feature based on the function assigned to the Flex Button in the System database. 

System provides you access to Station Speed Dial numbers.  You can easily enter and assign any 
of the Station Speed Dial numbers to a Flex button. 

 

 

 

 9-6 iss. 4.0 

 



ECS                 Phontage Desk-top Installer & User Guide 
 

To enter and assign a Station Speed Dial to a Flex button; 
 Place the mouse pointer over the desired 

Flex Button. 
 Right click the mouse to display the Speed 

Dial number entry window. 
 Use the pull-down menu to assign the Speed 

Dial bin number (for iPECS-100, bins 00 to 
19 or for the iPECS-300, bins 000 to 099). 

 Enter the number to be dialed. 
 Enter an optional label for the Flex Button. 
 Select Save to store the number and return to the Flex Button window. 

 

 
NOTE: If a Flex button is assigned for Paging, the Speakerphone must be activated prior to 
selecting the Page button. 

 
* iPECS 100/300/600 support this window only. The other system can do this function with IP Phone window and Flex Button window. 
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10 iPECS System Integration Features 
The iPECS system supports special functionality employing the special characteristics of the 
Phontage PC as a terminal.  The integration of the iPECS system and Phontage PC enables 
enhanced audio file capture and management features including: 

 Automatic Call Recording, Phontage or 3rd party 
 Voice Mail Back-up Station 

 

10.1 Automatic Call Recording 
When enabled in the iPECS system, conversations of the Phontage and/or other 3rd party iPECS 
users are recorded to the hard drive of the Phontage PC.  Automatic recording is assigned under 
Program code 112 of the iPECS system.  Other stations in the system may be assigned to record 
conversations to the Phontage, “3rd party recording”. 

Recorded conversations are managed from the Recorded Call List, which will indicate the date, 
time and station number(s) that was party to the conversation.  Note that to record 3rd party 
conversations properly; the iPECS Phontage must be idle. 

 

 

 

 

 

 

 

 

10.2 Voice Mail Back-up Station 
When enabled in the iPECS system, the Phontage receives notification of voice mails for other 
3rd party iPECS system users.  Notification from the iPECS VMIM increments the Voice Message 
count shown in the Info & Video Console, see section 6.2.  The 3rd party Voice Messages are 
copied to the Voice Mail Message List where they can be managed and, if enabled in the iPECS, 
may be deleted by the Phontage user. 

To back-up and manage Voice Mails from the Voice Mail Message List, 
 Click the Voice Message icon in the 

Info & Video Console to open the 
Voice Message List. 
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 Select the desired station 
from the Station drop-down 
menu in the Message List 
window. 

 Select Backup, the messages 
are downloaded to the 
Phontage PC hard drive. 

 Use the Message List Tool bar 
and Audio controls to manage 
the displayed messages.  For 
3rd party messages, you must 
be enabled in the iPECS 
system to delete messages. 

 

Note: that a VMIM is required in the host iPECS system. 
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11 Smart Tray Icon & Menu 
When the iPECS Phontage application is executed, a tray icon is created.  The icon is displayed in 
the Windows system tray.  The Smart Tray Icon 
will display the status of the connection with the 
System (connected or disconnected), as well as 
message events as shown.  

Missed call SMS Waiting    New Voice Mail

 

 

A ‘right-click’ on the icon opens the Smart Tray Menu.  Selections in this menu include: 

 

Tray Popup Cancel select to close the Smart Tray Menu 

Call Assistance   select to open the Call Assistance 
Window. 

Recent Call List  select an item from the list to return call. 

Speaker Button  select to control the speakerphone. 

Show Main Window select to open the Phontage Main 
Window. 

Exit    select to close the iPECS Phontage application. 
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12 iPECS Phontage User Programming 
As previously noted, the iPECS Phontage operates in the same manner as the traditional IP phone.  
There are however several user programmable functions which are not supported due to differences 
in the platform, i.e. PC versus IP Phone.  The user programmable functions not supported by 
Phontage include: 

Station Answer mode; iPECS Phontage does not support Intercom Call Announce and, thus 
supports only Privacy for the Station Answer mode. 

Station Ring Download; iPECS Phontage can not download ring tone files from the  

System, the Phontage user can change the ring tone files stored in the iPECS Phontage folder, 
see section 5.1.2.7. 

Audio source control; iPECS Phontage has a single audio path and thus cannot support the dual 
path (headset and speaker) controls available with the traditional IP phone. 
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